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はじめに 
 

 

1. はじめに 
 
 
このマニュアルについて 
 
このマニュアルでは、vsmSnap 対応パネルをインストール及び設定することによりサードパーティ製の映像ル

ーターやスイッチャーを制御する方法について説明しています。この仕様は、vsmSnap パネルのバージョン

3.0 とソフトウェアコンフィグレーションに有効です。 

 
 
Look out for the following which indicate: 
 
  メモ：明確にしておきたいポイント。 
 
  ティップス：役立つティップスやショートカット 
 
  警告：注意が必要な時に警告します。 
 
 

Lawo ユーザー登録 
 
ダウンロードセンターへのアクセスや製品アップデートのお知らせを受けるには、次のサイトで登録してくだ

さい： 
 
www.lawo.com/user-registration. 
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vsmSnap について
 

 

2. vsmSnap について 
 
vsmSnap は、互換性のあるサードパーティ製の映像ルーター及びスイチャーのマトリックスクロスポイントを

制御するための LCD パネルで構成されています。 
 
全てのパネルには、テキスト表示と RBG バックライト付きの LCD ボタンがあります。ボタンの機能、ラベ

ル、色は vsmSnap.exe で定義することができます。ボタンはターゲットとなる映像スイッチャー/ルーターの

クロスポイントルーティングを変更することができます。また、マルチページの機能にも対応しています。パ

ネルの設定が完了するとスタンドアロンで動作し、TCP/IP ネットワーク接続で映像スイッチャー/ルーター

と通信することができます。 

 

システム要求: 

 vsmSnap 対応 LCD ボタンパネルが 1 台 

 互換性のある映像スイッチャーまたはルーターが 1 台 

 各 LCD ボタンパネルにデータをアップロードするための vsmSnap 設定用 PC 

 全てのパネル、映像スイッチャー/ルーター及び設定用 PC 間の TCP/IP イーサネット通信 

* 互換性のある映像スイッチャー/ルーターは、システム要求に記載されているプロトコルのいずれかをサポー

トしている必要があります。 

 

vsmSnap パネル 
LCD ボタンパネルは 4 種類あります。各パネルの寸法、電源容量等を含むデータシートについては、オタリ

テック㈱へお問い合わせ下さい。 

 
LBP17 - 17 LCD ボタン, RGB バックライト, 1RU LBP32-DT - 32 LCD ボタン, RGB バックライト, 

 
デスクトップ用 

 
 
LBP34 - 34 LCD ボタン, RGB バックライト, 2RU 

 
 
 
 

 
LBP51 - 51 LCD ボタン, RGB バックライト, 2RU 
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vsmSnap について 

 

 

2. vsmSnap について 
 
vsmSnap ソフトウェア 
 

２つのソフトウェアを使用して、システムを構築します： 

vsmDiscover.exe は、ネットワーク検出ツールです。vsmSnap 対応のパネルを検出し(イーサネット MAC アド

レスを使用)、ネットワーク上の有効な IP アドレスに MAC アドレスを割り当てます。 
 
vsmSnap.exe は、コンフィグレーションツールです。これは、設定データを作成して、各 vsmSnap 対応パネ

ルにアップロードするために使用します。ソフトウェアは複数のパネルと複数の映像スイッチャー/ルーター

をサポートしています。これにより、大規模ネットワークを管理することができます。ソフトウェアコンポー

ネントについては、オタリテック㈱へお問い合わせください。 
 
vsmSnap のコンフィグレーション 
 
パネルは未設定の状態で出荷されるので必ず vsmSnap.exe を使用してコンフィグレーションデータ(構成情報)

をアップロードする必要があります。それ以降は、データはパネル内に保存されるので、起動時にロードされ

ます。 
 
vsmSnap.exe を使用してコンフィグレーションを編集し、ネットワーク上の選択したパネルに新しい構成情報

をアップロードすることで、いつでも機能を変更することができます。構成ファイルは、.snap ファイルとし

て PC 上に保存できるので、色々な構成ファイルを簡単にいつでもロードですることができます。 
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システム要求
 
 
 
 

3. システム要求 
 

vsmSnap パネル 
Lawo の工場では、全パネルが適切なファームウェアでインストールされる必要があります。ファー

ムウェアは必ず 3.0 以上でなければなりません。 
 
１台のネットワークインストレーションで複数のパネルを管理することができます。 
 
ルーター 
映像スイッチャー/ルーターは、次のプロトコルのいずれかをサポートしているサードパーティ製の機器です： 
 

 Leitch 

 Network compact 

 Lawo Nova (KPF) 

 Datatek (D2800) 

 ACOS (DD35) 

 Pro-Bel (SW-P08) 

 DAIS 

 nVision (Serial) 

 nVision (TCP) 
 
一回のネットワークインストールで、最大 8 台の映像スイッチャー/ルーターを管理することができます。こ

のソフトウェアは、最大４レイヤーと 1024 入力/1024 出力をサポートします。通常、TCP/IP イーサネット

経由で通信されます。また、シリアル接続(RS-422)にも対応しています。各映像スイッチャー/ルーターを適

切に構成する必要があります。 

 

コンフィグレーション PC 
 
コンフィグレーションソフトウェアのインストールを実行するには、次のシステム要件を満たす PC が必要で

す。この PC はお客様支給となります。 
 

 OS： Windows7 以降 (32-bit または 64-bit). 
 

 Microsoft .NET Framework 4.6 
 

 ネットワークインターフェース= 100Base-T 
 
 

ネットワークインフラストラクチャー 
全てのネットワークコンポーネント (スイッチ、ケーブル等)は 100Base-T 以上が必要です。 
 
ネットワーク設定 
 
デバイス間の全ての通信は、TCP/IP イーサネットを介してやり取りされます。 
 
全パネル、映像スイッチャー/ルーター、設定用 PC は同じ IP レンジとサブネット内で固有の IP アドレス

を割り当てる必要があります。 

インストール＆セットアップ 

 



7 

インストール＆セットアップ 

 

4. インストール＆セットアップ 
 
 

チェックリスト 
 
システムを動作可能にするには、次の各ステップを完了して下さい： 
 

1. 設定用の PC にソフトウェアコンポーネントをダウンロード後、インストールします。 

2. 全てのデバイスをネットワークに接続し、vsmDiscover.exe を実行します(vsmSnap パネルを検出し、 

 TCP/IP 設定を行います)。 
 

3. ユーザーインターフェースから各映像スイッチャー/ルーターを設定します。 

4. vsmSnap.exe アプリケーションを使用して、システムを構成します。 

この章の後半で、これらの手順について詳しく説明します。 
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インストール＆セットアップ

ソフトウェアのイントール
 

4.1  

ソフトウェアのインストール 
 
全てのソフトウェアコンポーネントはダウンロード可能ですので、詳細についてはオタリテック㈱までお問い

合わせ下さい。 
 

1. 設定用の PC がシステム要件を満たしているか確認して下さい。 
 

2. .zip ファイルをダウンロードし、ローカルフォルダで解凍します。vsmSnap と vsmDiscover の両方に

対応するファイルが４つあることを確認して下さい。 
 

3. vsmSnap.exe インストーラー(Setup.exe)を実行して、画面上の指示に従って下さい。インストールを 

 実行するには、管理者権限が必要になります。 
 

4. インストールが完了したら、Windows アップデートを実行して、Microsoft.NET Framework を更新し 

 ます。(vsmSnap は Microsoft .NET Framework 4.6 が必要です)  
 

インストールが正常に終了すると、vsmSnap アプリケーションが Windows のスタートメニューから

起動します。ソフトウェアの操作については、後程説明します。 

 

Windows 7 Start Menu 
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インストール＆セットアップ 

ネットワークの接続とコンフィグレーション 

 

4.2 ネットワークの接続と設定 
 
ソフトウェアをインストールしたら、次に全てのデバイスをネットワークへ接続し、vsmDiscover を実行しま

す。パネルは、MAC アドレスが割り振られて状態で LAWO の工場から出荷されます。vsmDiscover は、ネ

ットワーク上(MAC アドレスより)にあるすべての vsmSnap デバイスを検出するために使用され、IP アドレ

スを割り振ります。 
  

1. 各 vsmSnap パネルを接続し、ターゲット設定用の映像スイッチャー/ルーターと設定用の PC をネッ

トワークに接続します。全ての要素がシステム要件を満たしていれば、任意のネットワークトポロジ

ーを利用可能になります。 

2. 設定用の PC で、全てのソフトウェアを格納しているローカルフォルダを開きます。vsmDiscover.exe

をダブルクリックして、アプリケーションを開始します。起動時に、ネットワーク上の全てのパネル

がスキャンされ、vsmSnap で使用できるパネルが一覧で表示されます。リストに何も表示されない場

合、F5 を押すかまたは、Discover→Start detection を選択して新しいスキャンを開始します。  
3. パネルを選択し、Properties を表示します。そして、次に説明する“Network”設定を編集します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Apply をクリックします。 

5. ネットワーク上で接続されている各 vsmSnap パネルに対して繰り返し設定します。 

 

ネットワーク設定 
殆どのネットワークは、動的 IP アドレスの割り当てをする DHCP サーバーをサポートしています。これは、

IP アドレスを取得する最も安全な方法ですが、DHCP のデメリットとして、割り当てられた IP アドレスに利

用可能期“リース期間”を設けているため、デバイスが⾧期間使用されない場合に変更される可能性があるとい

うことです。これを回避するために、固定の IP アドレスを手動で割り振ることもできますが、他のデバイス

と IP が競合しないようにご注意下さい。プネットワークの接続とコンフィグレーション 

（DHCP を介した）動的 IP アドレスを選択するには、DHCP Address を True に設定し、Apply をクリック

します。ネットワーク上の DHCP サーバーが自動的に IP アドレスを割り当てます。(上の画像を参照してく

ださい) 
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インストール＆セットアップ 

ネットワークの接続とコンフィグレーション 
 

固定の IP アドレスを割り当てるには、Gateway、IP Address、および IP Mask フィールドを手動で入力しま

す。 

オプションで、ネットワーク名を編集して、ネットワーク内の各パネルを識別しやすくすることができます。 
 
  各パネルは、ターゲットのルーターと同じ IP レンジとサブネット内にある IP アドレスが必要です。 
  
オプションで、ネットワーク名を編集して、ネットワーク上の各パネルを識別しやすくすることができます。

ご不明点については、ネットワーク管理者へお問い合わせ下さい。 
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インストール＆セットアップ 

スイッチャーの設定 

 

4.3   スイッチャーの設定 
 
全ての vsmSnap パネルのネットワーク設定が完了したら、次に各映像スイッチャー/ルーターの設定を確認

します。 
 
下の画像は、Panasonic AV-HS6000 スイッチャーのユーザーインターフェースです。他のモデルについては、

製品マニュアルを参照して下さい。 
 
次の重要な項目として: 
 

 各映像スイッチャー/ルーターは、vsmSnap パネル及び設定用の PC と同一の IP レンジ/サブネット内

で存在できる IP アドレスが必要です。 
 

 ターゲットポートは、62010 に設定します。 

 
AV-HS6000: Switcher コンフィグレーション 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

AV-HS6000: SYS → SYSTEM → Network 
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インストール＆セットアップ 

スイッチャーの設定 
 
AV-HS6000: PLUGIN → PLUGIN Maint → Configuration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
AV-HS6000: PLUGIN → Plugin 1-6 → Ext Panel Settings 
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コンフィグレーション  

 

 

5. コンフィグレーション 
 
 
全てのパネルと映像スイッチャー/ルーターのネットワーク設定が正しく構成できたら、vsmSnap.exe を使用

し各機能を設定することができます。 
 
ソフトウェアは、複数のパネルと複数の映像スイッチャー/ルーターに対応しています。これにより

vsmSnap.exe アプリケーションのシングルインスタンスから大規模ネットワークを管理することができます。 
 
 

各映像スイッチャー/ルーター向けに以下の項目を設定可能です： 

 入力と出力信号の名前とラベルを定義する。 

 特定の接続を防ぐために、クロスポイントに強制的に制限をかけます。 

各パネルで以下のことが可能です： 

 ターゲットの映像スイッチャー/ルーターを割り当てる。 

 ボタン機能、テキストラベルとカラーを定義する。 
 
設定が完了したら、コンフィグレーションデータをネットワーク上のパネルにアップロードする必要がありま

す。パネルにアップロードしたら、それ以降は、コンフィグレーションデータはパネルに保存され、起動時に

ロードされます。 
 
vsmSnap.exe を使用してコンフィグレーションを編集し、またネットワーク上のパネルに新規のコンフィグレ

ーションデータをアップロードすることにより、いつでも機能を変更することができます。 
 
コンフィグレーションは、.snap ファイルとして設定用の PC に保存/ロードできるため、様々な設定を簡単に

保存/リロードすることができます。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

コンフィグレーション 
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コンフィグレーション 
ソフトウェアの使用 

ソ 

5.1 ソフトウェアを使用する 
 
vsmSnap アプリケーションは、Windows スタートメニューから起動できます： 

Start → All Programs → VirtualStudioManager → vsmSnap → vsmSnap： 

 
 
 
 
 
 
 
 
 
 
起動時に、 “コンフィグレーション・ツリー”(ウィンドウの左側)に何も設定されていない New Configuration

が表示され、Properties、Panels、Routers が表示されます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
既存のコンフィグレーションを開くには、File →Open (または、File →Recent Files) を選択し、.snap ファイ

ルを選択します。コンフィグレーション・ツリーは更新され、全ての構成されたパネルとルーターがロードさ

れます： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
＋と-ボタンを使用して、ツリーの中を展開したり閉じたりします。

コンフィグレーション 
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コンフィグレーション 

ソフトウェアの使用 
 

コンポーネント(パネル等)を選択します。その設定とオプションは右側の“パラメータエリア”に表示されま

す： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
操作は、”パラメータエリア”の専用のボタン、ツールバーとメインメニュー、または”コンフィグレーショ

ン・ツリー”でコンテンツメニューを右クリックするといった 3 つの方法から実行できます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
いずれの場合も、画面の下部に最後の操作のステータスが表示されるようになっています。 

パネルの機能をプログラムする前に、パネルとターゲットルーターの両方を現在のコンフィグレーションに追

加する必要があります。これらのステップはどちらの順序で実行してもかまいません。 

既存のコンフィグレーションをクリアにして新たにコンフィグレーションデータを作るには、File→New を選

択します。 

コンフィグレーション・ツリーのマクロの入力は、このバージョンの vsmSnap.exe ソフトウェアではサポー

トしていないのでご注意下さい。 
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コンフィグレーション 

スイッチャーの追加 

コンフィグレーションャーの追コンフィグレーション信号の定義 

5.2 スイッチャーを追加する 
 
制御する全ての映像スイッチャー/ルーターは、以下の手順でコンフィグレーションを手動で追加する必要が

あります。また、映像スイッチャー/ルーターはこのパートのコンフィグレーションを実行する場合、オフラ

インでもオンラインでもかまいません。 
 

1.  ルーターを選択して、Add Router を選択します(または、ツールバーの New Router ボタンをクリック

します)。“Router Configuration”ウィンドウが現れます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 以下の通りに“Router Configuration”を編集します： 
 
Protocol ドロップダウンメニューからプロトコルを選択します(例：pro-bel SW-P-08 等)。 
  
Name ルーターの名前を入力します。この名前は vsmSnap.exe ソフトウェア内で使用され、複

数のデバイスを構成する時に特に便利です。 
  

Connection ドロップダウンメニューから Serial–RS422 または TCP/IP のいずれかを選択します。

TCP/IP を使用する場合、IP アドレスとポート番号を入力する必要があります。 
  

IP Address ルーターの IP アドレスを入力します。 
  

Port ポート番号を 62010 に設定します。 
 
  IP アドレスとポート番号は映像スイッチャー/ルーターのユーザーインターフェースで定義されたものと一

致しなければなりません。 
 
# Layers, #Inputs, 

#Output 

ルーターがサポートするレイヤー数(最大４)と制御したい入力信号/出力信号の数

(最大 1024)を入力します。 
  

Layer Base, InputBase,  

Output Base 

ルーターがより多くの入力と出力に対応している場合、このフィールドを使ってオ

フます。例えば、Inputs を 8、Input Base を 0 と指定した場合、ルーターから制

御できる信号は最初の 8 入力となります。  
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コンフィグレーション 

スイッチャーの追加 
 

3. 全てのフィールドが入力できたら、OK をクリックするとルーターがコンフィグレーションに追加さ

れます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
この段階では、名前の左側に出てくる黄色ハザードマークは正常であることを示しています。これは、ルータ

ーにパネルが割り当てられていないことを示しています： 
 

4. これらの手順を繰り返して、コンフィグレーションが必要な全てのルーターを追加します。 

変更が必要な場合は、コンフィグレーション・ツリーにあるルーターを選択し、Modify をクリックす

ると “Router Configuration”ウィンドウが開きます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
既存のルーターを削除するには、コンフィグレーション・ツリーから削除したいルーターを選択して右クリッ

クし、Remove Router を選択します： 
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信号の定義 
 

5.3 信号を定義する 
 
ルーターのコンフィグレーションが追加されたら、信号の名前とラベルを編集してクロスポイントを設定しま

す。 
 

1.  コンフィグレーション・ツリーの Routers を開き、レイヤーを選択します(例：Layer 1)。右のパラメ

ータエリアに Signals と Restrictions の２つのタブが表示されます： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Signals を選択して、信号の名前とラベルを編集します。 

新しいコンフィグレーションでは、上の画像に表示されているように全ての信号に一般的な名前と空

のラベルが付けられます。この例では、R1.1.In01=Router 1、Layer 1、Input １となっていて、空の

ラベルのフィールドは常に(None)と識別されます。 
 
次のページの説明にしたがって、両方のフィールを編集することができます。 

信号ラベルは、パネルの操作中にソース及びターゲットの選択ボタンに表示されるものであることにご注意く

ださい (ボタンラベルが設定されていない場合): 
 
 
 
 
 
 
 
また、コンフィグレーションソフトウェアの中でも使用されます： 
 
 
 
 
 
 
 
 

 
Label フィールドを空のままにすると、Name フィールドが表示されます(パネルとコンフィグレーションソフ

トウェアの両方)。全ての信号に名前が必要です：Name フィールドを削除することはできません。 
 
また、パネルの LCD ディスプレイに合わせてテキストは自動的にサイズが変更されます。例えば、短いラベル(CAM1)は

⾧いラベル(CAMERA1)より大きく表示されます。To remain legible, 読みやすくするために、最大 12 文字が推奨されます。 
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信号の定義 
 

5.3.1 信号の名前とラベルを編集する 
 

1. Name または Label を編集するには、フィールドにテキストを入力して Enter キーを押します： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.  Label を削除するには、フィールドをクリックして選択し、キーボードの DELETE キーを押し、

Enter を押します。入力したテキストが更新されて(None)が表示されます。 
 
信号の名前は削除することができないのでご注意ください。 

 

複数のエントリーを編集するためのショートカット 
 
空の Label フィールドの最後に増分値を追加すると、ソフトウェアはその後全ての(None)ラベルを自動的に

補完します。これは、全ての入力と出力のラベリングを高速に設定します。例えば： 
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信号の定義 
 
入力する Name と Label が多数ある場合は、Excel のシートから入力項目をコピー＆ペーストすることができ

ます： 

1. 初めに、テキストを含んだシートをエクセルで作成します。両方のコラムを選択してコピーします。 

2. 次に、vsmSnap.exe で Select All ボタンを使用して全ての信号を選択します。右クリックし Paste 

Signal Names を選択すると、コピーされたフィールドが入力されます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. または、Name と Label を範囲選択して挿入する場合は、上記の手順を繰り返しますが、キーボード

の Shift を押して信号側も範囲選択します： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Linking Layers 
ルーターが複数のレイヤーに対応している場合、Link Layer...ボタンと Unlink Layer...ボタンを使用して、レ

イヤー間で信号名とラベルをリンクするかどうか選択することができます。 
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信号の定義 
 

5.3.2 クロスポイントの制限 
 

1. Restrictions タブを選択すると、クロスポイントの制限を設定することができます。例えば CAM 01

を MON 01 へ接続、CAM 02 を MON 02 へ接続といった特定の接続を避けたいときに使用されま

す： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 個々のクロスポイントをクリックして、制限を追加または削除します。赤の X は、制限がかけられて

いることを示します。 
 

3. Set 1:1 ボタンを使用して、同様の番号のクロスポイントを全て制限します：例えば In 01 から Out  

 01 へ、In 02 から Out 02 へ等。 
 

4. 全ての制限を削除するには Clear ボタンをクリックします。 

ルーターが複数のレイヤーをサポートしている場合、Copy to all Layers ボタンと Edit all Layers オプ

ションを使用することができます。シングルレイヤーの場合、これらのオプションは使用できません。 
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パネルの追加 

コンパネルの追加 

5.4 パネルを追加する 
 
全てのパネルは、コンフィグレーションを手動で追加する必要があります。 

パネルに電源が入っていてネットワークに接続している場合、Detect Panels をクリックすると最も簡単な方

法で検出されます。 

また、コンフィグレーションをオフラインで設定している場合、仮想パネルを追加してから後で物理パネルの

MAC アドレスを編集できます。 
 
オンラインの場合 (Detect Panels) 
 
この方法を使用するには、全てのパネルがオンラインであり、ネットワークの有効な IP アドレスが割り振ら

れている必要があります。 

1. 準備ができていない場合、vsmDiscover を実行してネットワークに接続されている全てのパネルを検 

 出し、適切な TCP/IP 設定をして下さい。 

2. vsmSnap.exe のコンフィグレーション・ツリーで、Panels と Detect Panels を選択します(またはツー 

 ルバーの Detect Panels ボタンをクリックします) 。 

 それに応じて、パネルリストとコンフィグレーション・ツリーが更新されます： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
パネルが検出されない場合、次の点を確認して下さい： 

 電源が入っていて、ネットワークに接続していること。 

 パネルはネットワークの有効な IP アドレスが割り振られていること。ネットワークの接続と設定を参

照して下さい。 
 vsmSnap が有効になっており、且つ正しいファームウェアが適用されていること。ファームウェアバージョンは、

3.0 以降です。 

 ネットワークにプロトコルの制限がないか。その場合、後で説明する Poked Devices 機能を試して下さい。 
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パネルの追加 

 
オフラインの場合 (New Panel) 
 
次の手順は、コンフィグレーションをオフラインで設定した場合や物理パネルがまだインストールもしくは接

続されていない場合に使用します。 
 

1. ツールバーから New Panel ボタンを選択すると "Panel Properties"ウィンドウが開きます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 以下の通りに"Panel Properties"を編集します：  
Name パネルの名前を入力します。名前は vsmSnap.exe ソフトウェア内で使用され、複数のデ

バイスを構成する場合に便利です。 

Buttons ドロップダウンメニューからボタンの数を選択します。これはパネルの数と一致しなけ

ればならず、後で変更することはできません。 

Mac Address パネルの MAC アドレスがわかっている場合は、チェックボックスをオンにして、ここ

にアドレスを入力します。MAC アドレスは、vsmSnap パネルの RJ４５イーサネットコ

ネクタの横にあるステッカーに記載されています。 

MAC アドレスが不明な場合、チェックボックスにチェックをいれずに続けます。MAC

アドレスは後で変更することができます。 

 
  MAC アドレスは、ネットワークに対して各パネルを識別するものです。ただし、コンフィグレーション

データの転送を含む全ての通信は、TCP/IP を介して処理されます。従って、パネルがネットワークに

接続したら、コンフィグレーションに MAC アドレスを入力し(上記を参照)、vsmDiscover を実行してそ

の MAC アドレスをネットワークに有効な IP アドレスに割り当てる必要があります。 
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パネルの追加 
 
Router ドロップダウンメニューから制御するターゲットのルーターを選択します。ルータ

ーが未設定の場合、このフィールドは空欄にして下さい。ルーターは後で割り当て

ることができます。 

コンフィグレーションで、一度に 1 つのルーターを１つのパネルに割り振ることが

できます。従って、複数のパネルからターゲットデバイスを制御する場合は、最初

にルーターの定義をコピーする必要があります。(ターゲットルーターの割り当て

を参照して下さい) 

Screensaver ドロップダウンメニューからオプションを選択します。スクリーンセーバーを有効

にすることで、LCD ボタンディスプレイの寿命を延ばすことができます。 

Display Source Labels on 

Target Buttons 

ターゲットの LCD ボタンのターゲットラベルの下にソースラベルを表示したい場

合にこのチェックボックスを入れます。チェックボックスがない場合、ターゲット

ラベルだけが表示されます。 

 

 
 

コンフィグレーション
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パネルの追加 
 

 
3. 全てのフィールドが完了したら、OK をクリックします。仮想パネルがコンフィグレーションに追加

されます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. これらのステップを繰り返して、コンフィグレーションに必要な全てのパネルを追加します。 

ステップ 2 でパネルの MAC アドレスを入力した場合、パネルはネットワークに接続され、vsmDiscover を使

用して設定されるとすぐにコンフィグレーションソフトウェアによって表示されます。 

MAC アドレスを空のままにした場合、後でアドレスを入力する必要があります。 

変更する場合は、コンフィグレーション・ツリーのパネルを選択し、Modify をクリックすると“Panel 

Properties”ウィンドウが開きます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

コンフィグレーション 
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パネルの追加 

パネルの追加 
パネルを削除するには、コンフィグレーション・ツリーからパネルを選択し、右クリックして Remove Panel を選択しま

す：  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



27 

コンフィグレーション 

ターゲットデバイスの接続 
 

5.5 ターゲットデバイスの接続 
 
各 vsmSnap パネルは、単一の映像スイッチャー/ルーターを制御できますが、必要に応じて同じ映像スイッ 

チャー/ルーターを複数のパネルで制御することができます。 
 
コンフィグレーション内で一度に１つのルーターを１つのパネルに接続できます。従って、複数のパネルから

同じターゲットデバイスを制御する場合、最初にルーター定義のコピーを作成する必要があります。 
 
コンフィグレーション・ツリーを調べることで、現在の割り当てを確認することができます： 
 
 
 
 
 
 
 
 

 
 ルーター定義を複製するには： 
 

1. 最初に、必要に応じて全ての信号名、ラベル及びクロスポイント制御を定義し、ルーターのコン 

 フィグレーションが完了していることを確認します。完了していない場合は、後で複製し直す必要が

あります。 
 

2. 次に、コンフィグレーション・ツリーの中からルーターを選択し、右クリックして Clone Router...を 

選択します。コンフィグレーションウィンドウが表示されるので複製用の新しい名前を入力します。 
 

コピーされたデバイスのフィールドと一致するように編集します。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. OK を選択して、コンフィグレーションにルーターを追加します。 

4. パネルごとにルーター定義が作成できるまで、ステップ 2 と３を繰り返して下さい。 
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 ルーターをパネルに接続するには： 
 
ルーターを各パネルに割り当てる方法はいくつかありますが、最も簡単な方法はコンフィグレーション・ツリ

ー上でルーター定義をパネルにドラッグ＆ドロップすることです： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
割り当てられると、ルーター名の横の⚠マークが消え、それに応じてツリー構造も更新されます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
既存のルーターが割り当てられているパネルにドラッグ＆ドロップすると、それまで割り当てられていた情報

が書き換わるのでご注意下さい。 
 
全てのパネルがターゲットルーターに割り当てられるまで繰り返して下さい。
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割り当てたデバイスを削除するには、コンフィグレーション・ツリーのパネルを開き、パネルの下にあるルー

ター定義を選択した後に右クリックし、Detach from Panel を選択します： 
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5.6 ボタンを定義する 
 
ルーターが接続されたら、次にパネルに情報を埋め込みます。 

各 LCD ボタンに、機能・ラベル・色を割り当てることができ、また各パネルは複数ページに対応しています。

ボタンを設定するには、主に 2 つの種類の機能があります： 
 

 ソースとターゲット選択ボタン --- 接続されている映像スイッチャー/ルーターのクロスポイント 

ルーティングを制御します。 

 特殊機能 – ページナビゲーション、ロックパネル等 
 
基本理念 
 

1.  コンフィグレーション・ツリーでパネルを選択し、“パラメータエリア”の上半分を見て下さい。ここ

ではパネルを視覚的に表現しています： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
機能が割り当てられていない場合、グレイのボタンが表示されます。 

既存のコンフィグレーションを編集している場合、ボタンラベルと色が表示されます(上記を参照)。 

2. Zoom メニューのドロップダウンメニューを使用してコンフィグレーションウィンドウ内に収まるよ

うにパネルのサイズを変更します。 

ここでの例は、上の行がソース選択ボタン(青)、下の行がターゲット選択ボタン(緑)、そしてページ間を移動

するための機能ボタン(オレンジ)があります。 

Zoom メニューの右側にあるオプションを使用すると、ページの追加や表示が可能になります。Zoom の左にある  ボタ

ンは、現在の表示をピン止めするために使用されます。これについては後程説明します。 

ウィンドウの下半分には、3 つのタブがあります： Panel・ Functions・Button. 

3. Panel タブを選択して、“パネルプロパティ”を変更するために Modify (前述)を選択します。 

Run as Remote Panel オプションは、この vsmSnap.exe ソフトウェアで対応していないのでご注意下さい。 

4. Functions タブを選択して、特殊機能を割り当てます。 

 Button タブを選択して、source/target 選択 ボタンを作成するか、他の ボタンオプション を設定しま 

 す。それぞれの場合、パネル表示からボタンを選択し、ラベル、機能、色を定義します。 
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この例では、中央の行の最初のボタンは MON 01 というラベルのついた出力先を選択するように構成されて

います。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  最後の割り当てを元に戻すには、パネル表示の上にある Undo ボタン をクリックします。ボタンの位

置(例：MON01 等)を移動するには、パネル表示のボタンを元の位置から新しい位置にドラッグ＆ドロッ

プします。 

 機能をクリアするには、ボタンを右クリックし、Clear を選択します。
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ボタンの定義 
 

5.6.1 ソース＆ターゲット選択ボタンを作成する 
 
Button タブからソース/ターゲットの選択ボタンを作成することができますが、通常はコンフィグレーショ

ン・ツリーからパネル表示にドラッグ＆ドロップすることでより早く設定することができます： 
 

1. コンフィグレーション・ツリーからボタン設定したいパネルを選択します(例：LBP34)： 
 
 
 
 
 
 
 
 
 
 

 

２． パネル表示の左上にある（Zoom の左）"ピン"ボタン  をクリックすると、アイコンが マークに   

変更され、現在の表示がピン止めされます。このモードでは、現在のパネルを表示したままコン 

フィグレーション・ツリーの中で選択を行うことができます。 

3. パネルのターゲットルーターを開き、割り当てたい信号を選択します： 

 ボタンを選択した後に個々の信号を一つずつ選択する方法 

 または、最初の信号をクリックし、キーボードの Shift キーを押したまま最後の信号までを範囲指定し

て選択します。 

この例では、“CAM 01”から“R1.1.In24”までの 24 入力信号を選択しています： 
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4. コンフィグレーション・ツリーから範囲指定された信号を割り当てたいボタンの最初のボタンにド 

ラッグ＆ドロップします。信号はパネル全体の左から右へ、上から下へと順に割り当てられ、 

24 のソース選択ボタンが作成できます(デフォルトの色は青)。 
 
既にボタンに信号が割り当てられている場合は、それらの機能が上書きされるのでご注意下さい。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. この手順を繰り返して、さらにソース及びターゲット選択ボタンを設定します。次の例では、最初の 

8 つの出力信号を次の空きボタンへ割り当て、8 つのターゲット選択ボタンを作成します(デフォルト 

の色は緑)。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. パネルの設定が完了したら、“ピン”アイコン  をもう一度クリックし、ピン留めを解除します。 
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5.6.2 特殊機能の設定 
 
Function タブからパネル表示のボタンへドラッグ＆ドロップすることで、同様の方法で特殊機能を割り当て

ることができます： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
特殊機能は、次のカテゴリに分類されます： 
 
Navigation 

 Next --- 次のページへ送る。 

 Previous --- 前のページに戻る。 

 Esc --- 1 ページへ移動し、全てのターゲットの選択を解除する。 

 Back --- 最後に使用したページに戻る。 

 Goto --- 特定のページへジャンプする。Button タブを選択し、ページ番号を選びます(例：Page2)： 



35 

コンフィグレーション 

ボタンの定義 
ボタンの定 
Breakaway 

ターゲットルーターが複数のレイヤーをサポートしている場合、この機能が適用されます。これらを使用して

レイヤー間のクロスポイントスイッチングを"breakaway(分離)"することができます。 

例えば、ビデオレイヤー上のクロスポイントだけ切り替えることができます： 
 

 Select Layer --- 選択したレイヤーだけのクロスポイントを切り替えることができます。 

 Exclude Layer --- 選択したレイヤーのクロスポイントを無効にすることができます。 

いずれの場合も、Button タブを選択して、レイヤーを選択するかまたは選択解除するレイヤーを選びます。

(例：Layers 2、3、4)： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Snapshot 

vsmSnap は、スナップショットを使用してルーターのクロスポイントのステータスを保存したり、呼び出し

たりすることができます。最大 16 個のメモリバンクが利用可能で、各バンクには 16 個のクロスポイントの

状態を保存することができます。 
 

 Exec – 最大 16 個の選択したクロスポイントを選択する。 

 Store --- 選択したクロスポイントをメモリバンクに保存する(1 から 16)。 

 Recall ---選択したクロスポイントをメモリバンクから呼び出す(1 から 16)。 

Store と Recall には、Button タブを選択し、指定するバンクを選択します。ドロップダウンメニューから 0～

15 の番号をバンクにつけることができます： 
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Target 

 Lock – 指定したターゲットをロックします。ロックされたターゲットへの接続は変更することができ

ません。 
 
Miscellaneous 

 Display --- 一般的な表示のボタンです。 

 Lock Panel --- パネルをロック(またはロックの解除)します。ロックされると、全てのボタンが無効に

なります。オペレーターは、ボタンを 3 秒以上⾧押しして状態を切り替える必要があります。 

 Info --- パネルのステータス情報を LCD ボタンに表示します。オペレーターは適当なボタンを押して

“info”状態をキャンセルすることができます。 

 Contrast – 全ての LCD ボタンのコントラストを調整することができます。 
 

5.6.3 ページの追加 
 

1. ページ機能をさらに追加するには、パネル表示の上部にある Add Page をクリックします。クリック

するたびに新規のページが追加されます： 
 
 
 
 
 
 

 
2.  新規のページを切り替えるにはページボタンのいずれかを選択します： 

 
 
 
 
 
 
 
 

3. ページの名前の変更や削除するには、ページの選択ボタンを右クリックします： 
 
 
 
 
 
 
 
 
 
 
 

4.  オペレーターがページナビゲーションを使用する場合、特殊機能用に各ページのボタンをいくつか予

約する必要があります：Next、Previous 等(詳細は特殊機能を参照して下さい)。 
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5.6.4 ボタンタブ 
 
Button タブには、ソース/ターゲットボタンや特殊機能ボタンを割り当てるための別の方法があり、さらにボ

タンのラベルや色等のオプションも設定可能です： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ボタンタブから機能を割り当てる 
 

1. パネルビューから割り当てたいボタンを選択します。 

2. Button タブのドロップダウンメニューから Special Function を選択します。 

または、Signal (In/Out) の右にある“Select Input”(または“Select Output”)矢印ボタンをクリックして、

入力(または出力)信号を選択できるポップアップウィンドウが開きます。一旦割り当てられると、信

号のラベルまたは名前が Signal (In/Out)ボックスに現れます。 
 

3. 次のページの説明に従って、ボタンの Label と Color フィールドを編集します。 

このバージョンの vsmSnap.exe ソフトウェアでは、他のオプション(Move Unassigned Buttons 等)を

サポートしていないのでご注意下さい。 
 
ボタンラベル 
各ボタンには、ソースとターゲット選択ボタンの Label フィールドがあり、ソースやターゲット選択ボタンの

信号ラベルや特殊機能ボタンの独自ラベルをオーバーライドします。 
 
例えば、ルーター信号リストで定義された信号ラベルを使用するには、ボタンの Label フィールドを空にして

おく必要があります(上記を参照)。この場合、信号ラベル(例： CAM 01)が表示されます。信号ラベルが定義

されていない場合、信号名(例：R1.1.In01)が表示されるのでご注意下さい。 
 
または、ボタンの Label フィールドにテキストを入力して、信号ラベルをオーバーライドできます： 
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Label フィールドの横にある 2 つのボタンを使用して、ラベルをクリア(信号ラベルを戻す)するか、ボタンの

ラベルエディターを開きます(テキストのルックをカスタマイズできます)： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
テキストは、パネルの LCD ディスプレイに合わせて自動的にサイズ変更されますこれは、短いラベル(CAM 

1)が⾧いラベル(CAMERA 1)よりも大きく表示されることを意味します。 
 
12 文字までの文字数であれば解読可能だと思われます。 
 
Button Color 
 
機能が割り当てられると、ボタンにはデフォルトの色が付きます：ソース選択は青、ターゲット選択は緑、ペ

ージナビゲーションはオレンジ等。 
 
必要に応じて、Color フィールドから色を選択することで、デフォルトの色を上書きすることができます： 
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5.7 コンフィグレーションデータのアップロード 
 
パネルとそのターゲットルーターのコンフィグレーションが完了したら、次にコンフィグレーションデータを

アップロードします。アップロードに成功すると、データはパネルに保存され、起動時にロードされます。 
 
この操作はいつでも使用でき、パネルの機能を更新することができます。 

1. ツールバーから Upload Configuration ボタンを選択すると、ダイアログボックスが開きネットワー 

 ク上で検出された全てのパネルの一覧を表示します。 
 

2. アップロードしたいパネルのチェックボックスで選択します： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
リストが空の場合は、全てのパネルが接続され、ネットワーク上で正しく構成されているか確認して下さい。 

いずれかのパネルが赤くハイライトされている場合、そのパネルはネットワーク上で検出されていますが無効

な IP アドレスが割り当てられていることを意味します。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
この場合、vsmDiscover を使用し、適宜 IP 設定を変更します。 
 

各パネルは、ターゲットルーターと同じ IP レンジとサブネット内にある IP アドレスが必要です。 
 
 

コンフィグレーション 
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コンフィグレーションデータのアップロード 
コンフィグレーションデータのアップロード 

3. パネルを選択したら、Start をクリックします。ダイアログボックスが表示され、パスワードが要求 

 されます。(これはパネルへの偶発的なアップロードを防ぎます) 
 

4. Password を入力します： デフォルト=1234 
 
(必要に応じて、パスワードを変更することができます：Change Password を選択し、新しいパスワードを 2

回入力します。新しいパスワードは。アップロード後にパネルに保存されます。) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. OK を選択してアップロードを開始します。Messages エリアにステータスと進捗が表示されます： 

 アップロードが成功すると、以下の確認メッセージが表示され、パネルが再起動します。これには数

秒かかります。これで、アップロードが完了したコンフィグレーションが実行されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 アップロードの失敗メッセージが表示された場合、ネットワーク接続とコンフィグレーションを確認

して下さい。 

アップロードが成功したように見えても、パネルが正しいコンフィグレーションで実行されていない場合、転

送時に無効なチェックサムが発生している可能性があります。その場合は、コンフィグレーションをもう一度

アップロードして、vsmDiscover が実行されていないことを確認して下さい。
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5.8 操作テスト 
 
パネルとターゲット映像スイッチャー/ルーター間のネットワーク通信が確立すると、パネルの背面にある青

い LED が点滅し、クロスポイントを設定することができるようになります： 

 

 

 

 

まず、ターゲット選択ボタン(例：Monitor 01)を押してから、ソース選択ボタン(例：Camera 01)を押します。 

 

ルーター接続のトラブルシューティング 
 
パネルがルーターと通信していないように見える場合、ネットワーク（シリアルインターフェイス）設定と

vsmSnap Router Configuration ウィンドウで定義した Layer Base と Input/Output Base 

を確認して下さい。似たような設定で構成されたサードパーティ製のデバイスについては、Configuration the 

Switcher を参照するか、そのメーカーのドキュメントで確認して下さい。 
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5.9 コンフィグレーションファイルの保存＆ロード 
 
全てのパネルとルーターのコンフィグレーションを*.snap ファイルとして PC に保存/ロードします。 
コンフィグレーションは定期的にバックアップすることをお勧めします。 
 
 
 
 
 
 
 
 
 
 
 

カレントのコンフィグレーションを保存するには：  

1. メインメニューから File→Save を選択するかまたは File→Save As を選択して、適切なファイル名を 

 入力します。ファイルは PC 上に*.snap ファイルとして保存されます。 

2. これ以降、ファイルを更新するには、File→Save を選択します(またはツールバーの Save アイコンを 

 クリックします)。 

ファイル名はコンフィグレーション・ツリーのトップに表示されます (例： AV HS6000-v3)： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 既存のコンフィグレーションファイルを開くには： 

3. File → Open を開き(または File → Recent Files)、*.snap ファイルを選択します。 

 Configuration ツリーが更新され、設定されたパネルとルーターが表示されます。 

4. パネルの機能を変更するためにコンフィグレーションを開いた場合、必ずネットワーク経由でパネル 

 にデータをアップロードして下さい。
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5.10 その他の機能 
 

Poked Devices 
 
 
 
 
 
 
 
 
 
 

ネットワークで“UDP ブロードキャスト”というプロトコルが制限されている場合、Tools メニューにあるこの機能が必要

になることがあります。 

この場合、Detect Panels 機能は自動的に vsmSnap パネルを検出しません。従って、次のようにパネルのリス

トを手動で設定する必要があります： 
 

1. Tools → Poked Devices... を選択して、ダイアログボックスを開きます： 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

2. Add Panel ボタンを使用して、ネットワーク上にある各パネルの IP アドレスを入力します。 

 これ以降、vsmSnap.exe は UDP ブロードキャストではなく、このリスト内の IP アドレスを使用して

検出します。 

3. X ボタンを押すと、選択したアドレスまたはリストをクリアします。 

4. Export ボタンは、リストを.txt ファイルとしてエクスポートします。 

 これにより、別のコンフィグレーション用 PC でリストをインポートして編集することができます。 
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5.11 メインメニュー 
 
キーボードショートカットを使用してメニューオプションを選択することができます。最もよく使用する機能

もツールバーに複製されますのでご注意下さい。 
 
File メニュー 
 
 
 
 
 
 
 
 

 
 New --- 新しく“ブランク”のコンフィグレーションを開きます。このオプションを使用する前に、

Save または Save As を使用して既存のコンフィグレーションを保存して下さい。 

 Open --- PC からコンフィグレーションファイルを開きます。コンフィグレーションは、*.snap ファ

イルとして保存されています。 

 Save と Save as --- カレントのコンフィグレーションを*.snap ファイルとして PC に保存します。 

 Recent Files --- 最近保存したファイルを開くためにこのメニューからオプションを選択します。 

 Exit --- コンフィグレーションソフトを閉じます。 
 
View メニュー 
 
 
 
 
 
 
 
 

 Back と Forward --- ツリーで最後に選択したいくつかのステップを前後に進みます。これを使用して、

パネルからルーター等の様々なコンフィグレーションを素早く切り替えることができます。 

 Matrix View --- このオプションは、このバージョンの vsmSnap.exe ではサポートしていません。 

 Sort xxx – このオプションを使用して、アルファベット順にコンフィグレーション・ツリーのコンポーネントを

並べ替えます。 
 
 

 

 

 

 

 

 

 

 

フィグレーショ 
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Tools メニュー 
 
 
 
 
 
 
 
 
 
 

 Detect Panels --- 全てのオンライン状態のパネルを検出します。Adding a Panel (オンラインの場合) 

 New Panel... --- バーチャルパネルを追加します。Adding a Panel (オフラインの場合) 

 New Router... --- 新しいルーターを追加します。 Adding a Switcher 

 Upload Configuration... – カレントのコンフィグレーションデータを全てまたは選択したパネルにアッ

プロードします。Uploading Configuration Data 
 

 Poked Devices... - その他の機能を参照してください。 
 

 Options... – ボタンの色などのデフォルトオプションを設定できるダイアログボックスを開きます。 
 
 
 
 


